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Publishing System

Operator’s Guide
The DIRECTOR/DIRECTOR PRO is a state-of-the-art CD/DVD publishing system and duplicator. It is designed to create, duplicate and verify most standard compact disc formats. This startup section will guide you through starting and configuring the DIRECTOR/DIRECTOR PRO application.

Application Startup

Starting the D CLIENT  Application

To start the D CLIENT application the steps are as follows:

· Create a shortcut for D CLIENT on your Local PC to the Director/Director Pro. Double click the D CLIENT icon on the Windows desktop. The D CLIENT application screen will now be displayed:
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· Place as many blank discs as required onto the input spindle.

D CLIENT Application Layout

The D CLIENT application is organized into a sequence of five pages accessible by tabs at the top of the screen 
• Status
• Data Image Editor
• Audio Image Editor
• Label Editor
• Audio Extractor
By completing information on these pages you control the actions of the DIRECTOR/DIRECTOR PRO to create, duplicate and verify CD/DVDs as well as print disc labels.

Tabs:

	Status
	Displays the status of jobs after they have been submitted for production.

	Data Image Editor
	Specifies the contents of a data CD/DVD to be recorded.

	Audio Image Editor
	Specifies the contents of an audio CD/DVD to be recorded.

	Label Editor
	Creates labels to be printed on the surface of CD/DVDs.

	Audio Extractor
	Rips Audio Files to WAV File


Creating Disc Images

The DIRECTOR/DIRECTOR PRO creates industry standard data (Mode 1 ISO 9660 level 2 with Joliet extensions) and audio (Red Book) CD/DVDs from scratch as well as duplicates existing CD/DVDs authored in most formats. In this section we cover how to create the CD/DVD contents from files residing on the local system or a remote system connected via a network. 

Data Disc Images

To create a data disc image:

· Click the Data Image Editor tab. The screen will now display:
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The Data Image Editor tab is divided into four panes. The top left pane lists all of the names and icons of the files and folders on the currently selected disk drive (source). The top right pane displays the contents of any item you click on in the top left pane along with its icon. The bottom left pane lists all the names and icons of files and folders on the CD/DVD that is being created (disc image). The bottom right pane displays the contents of any item you click on in the bottom left pane along with its icon.

Data Image Editor Toolbar

Horizontally at the top of the panes, which contains eight buttons: New Open, Save, Properties, Disc Capacity, CD/DVD, DVD, Wildcard. 
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Data Image Editor Toolbar:

	New Folder
	Creates a new volume.

	Open
	Opens an existing folder on the disc image.

	Save
	Saves files or folders.

	Properties
	Displays properties about the image:  volume title, Publisher, Data Preparer, Copyright File, Abstract File and Bibliographic File.

	Disc Capacity
	Allows selection of capacity of discs loaded into DIRECTOR/DIRECTOR PRO i.e. 74 minute/650MB, 80 minute/700MB, DVD 3.95GB and DVD 4.7GB.

	CD/DVD
	Lets DIRECTOR/DIRECTOR PRO know CD/DVD media is in use.

	DVD
	Lets DIRECTOR/DIRECTOR PRO know DVD media is in use.

	*.* Wildcard
	Allows specification of dynamic content


Static And Dynamic Content

The DIRECTOR/DIRECTOR PRO allows CD/DVDs to be created from both static and dynamic content. A finished CD/DVD created from static content will contain the exact files and folders that are specified when the disc image is created. A finished CD/DVD created from dynamic content will contain the files and folders that exist in specified locations at the time the job is submitted for recording (rather than when the disc image is created).

For example, specifying dynamic content when creating a CD/DVD layout would allow a job to be run every week that records the contents of a specific folder onto a CD/DVD without having to create a new disc image every time. In this case the contents of the folder (not the folder itself) can change.

To specify a file or folder on a disc image as containing dynamic content:

· Highlight the Volume which will be using dynamic source then Click the *.* check box.
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Adding Files And Folders

· Click the desired file or folder in the top left or right pane (source) and hold down the mouse button.

· Drag the file or folder over the CD/DVD icon in the lower right then release the mouse button 

· Files and folders can also be added to the disc image using the Open button.  A box appears choose the image and click he Open button the image will be added.

Removing Files and Folders

· Click the desired file or folder in the bottom left or right pane (disc image)

· Right click the file or folder and choose Delete from the toolbar which appears.

Creating New Folders

· Click the desired root or folder area in the left or right pane (disc image).

· Click the New Folder button on the toolbar.

Naming A Folder

· Right click the desired folder in the bottom left or right pane (disc image).

· Choose Rename from the drop down menu, which appears.

Saving The Current Disc Image File

Once a data disc image has been created, it must be saved for the DIRECTOR/DIRECTOR PRO to use it as a data source for recording. Disc images can either be saved as script files (with an “ISC” extension) or physical image files (with an “ISO” extension).

A script file (ISC) contains pointers to the source data files and is used as a guide at the time of recording the CD/DVD. Since a script file does not include the source data it is best used when producing unique projects with dynamic content, or when the source data will always be available to the DIRECTOR/DIRECTOR PRO. Or, if producing software, a “static” image would be best to ensure content.

A physical image file (ISO) is an exact replica of the final CD/DVD and contains all of the source data. It is therefore best used when producing static projects that are recorded on a regular basis, and when source data will not always be available to the DIRECTOR/DIRECTOR PRO. Please note that, depending upon the amount of data to be recorded, a physical image file can occupy as much as 700 MB of hard disk space.

To save a data disc image script file:

· Click the Save  button on the toolbar. The screen will now display:
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The file will automatically be saved with the .isc extension.

· Click the OK button. The screen will now display:
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· Select the volume and directory where you want to save the script file.

· Enter the name for the script file and click the Save button.

To save a disc physical image file:

· Click the Save button on the toolbar. The screen will now display:
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· Select the volume and directory where you want to save the image file.

· Enter the name for the image file.

· Change you the Save as type: to ISO.

This will make a standard ISO 9660 image file to the desired location.

Volume Properties

	Volume Label
	Enter the name you want to call the CD/DVD.

	Publisher
	Enter the name of the publisher.

	Data Preparer
	Enter the name of the person who prepared the CD/DVD.

	Copyright File
	Enter the file name that provides copyright information about the CD/DVD.

	Abstract File
	Enter the file name that describes the contents of the CD/DVD.

	Bibliographic File
	Enter the file name that provides bibliographic information about the CD/DVD.


· Click the OK button. The screen will now display:
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· Select the volume and directory where you want to save the physical image file.

· Enter the name for the physical image file and click the Save button.

Loading An Existing Script File

Once a data disc image script file has been saved it can be modified at a later date.

To load an existing script file:

· Click the Load Script button on the toolbar. The screen will now display:
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· Select the appropriate file and click the Open button.

Creating Disc Labels

The DIRECTOR/DIRECTOR PRO’s built-in label design software provides a quick and easy way to create simple disc labels that contain text and graphics. More sophisticated labels can be created by using the provided software included with the your printer.

To use the DIRECTOR/DIRECTOR PRO’s built-in label design software:

· Click the Label Editor tab. The screen will now display:
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The Label Editor’s main editing window consists of two concentric circles that graphically represent the surface appearance of a CD/DVD. 

Label Editor Menu Bar

Horizontally along the top of the Label Editor window is the menu bar, as depicted below:
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The menu bar contains eight buttons: New, Open, Save, Cut, Select Font, Point Mode, Text Mode and Import Picture.

Label Menu Buttons:

	New
	Creates a new disc label.

	Open
	Opens an existing disc label file (*.LBL).

	Save
	Saves the current disc label. 

	Cut
	Cuts the selected item

	Select Font
	Used to select the font, style, size and color before creating test on the disc label.

	Point 

Mode
	Used to select a piece of text, date field or graphic image so it can be moved, modified or deleted.

	Text Mode
	Used to create text on the disc label.

	Import Picture
	Used to place a graphic image file created using other software on the disc label.


Creating Text

Using the Text Mode tool, you can create horizontal text anywhere on your disc label. In addition, once the text has been entered it can be repositioned and its font and other attributes changed. To create text:

· Click the Text Mode button on the toolbar.

· Click where you want the type to begin.

· Enter the text you want.
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Changing Text And Text Attributes

To change the attributes of a piece of text once it has been entered:

· Click the Point Mode button on the toolbar.
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Double click the piece of text you wish to change. The screen will now display:

· To change the text that you previously typed in, edit the contents of the text box.
· To change the font, style, size or color, click the Select Font button. The screen will now display:
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· After making the changes click the OK button.
· Click the OK button.
Importing Graphics

Using the Import Picture tool, you can place graphics created using other software anywhere on your disc label. To import a graphics file:

· Click the Import Picture button on the toolbar. The screen will now display:
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· Select the graphics file you wish to import (supported formats include BMP, JPG, PCX, PNG, TGA, TIF and WMF).

· Click the Open button.

Resizing Graphics

To proportionally resize a graphic image after it has been imported:

· Click the Point button on the toolbar.

· Click the graphic image you wish to resize. A bounding box will appear around the image with eight solid squares (handles).

· Click and drag the appropriate handle until the image is the correct size and release the mouse button.
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Repositioning Text, Graphics and Dates

To reposition a piece of text, a graphic image or a date field after it has been created or imported:

· Click the Point button on the toolbar.

· Click and hold on the selected text or graphic image you wish to move.

· Drag the text or graphic image to the desired location and release the mouse button.

Centering Text and Graphics

To center text or graphic images after they have been created or imported:

· Click the Point button on the toolbar.

· Right-click on the text or graphic image. A pop-up menu, as depicted below, will appear. 

· You may center text horizontally only. You may choose to center graphics horizontally, vertically, or both. Clicking on the “Center” pop-up menu option centers the graphic horizontally and vertically.
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Deleting Text, Graphics And Dates

To delete a piece of text, a graphic image or a date field after it has been created or imported:

· Click the Point Mode button on the tool bar.

· Click the piece of text or graphic image you wish to delete.

· Click the Delete button on the menu bar or press the DELETE key on the keyboard. Optionally, you may right-click on the object as described in “Centering Text and Graphics” and then select delete in the pop-up that appears.
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Saving the Current Disc Label

Once a disc label has been created, it must be saved in order for the DIRECTOR/DIRECTOR PRO to use it as a source label for printing. Disc labels are saved as files with an “LBL” extension. To save a disc label:

· Click the Save button on the menu bar.

· Select the proper folder where you want to save the disc label file.

· Enter the name for the disc label file and click the Save button.
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Opening Existing Disc Labels

Once a disc label has been saved it can be modified at a later date. To open an existing disc label file:

· Click the Open button on the menu bar.

· Select the appropriate file and click the Open button.
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Utilizing .PDF Files for Printing (Command Module Client Only)[image: image41.png]Staus| Datamage Edor| Ao e Ecor Label et | Auco et |

0O = &

New Open save

&

cu

A

Select Fant.

N

Pairt mode

Text made  Iport piture.






Utilizing .PDF Files for Printing – Command Module Only
	Note:  When submitting PDF files for printing via D-Client.  The drivers for the printer in which you are submitting to, must be loaded on the client machine or workstation as D-Client.  
 Please ensure that the printer that you are submitting to is set as the default printer.
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Audio Disc Images
The DIRECTOR/DIRECTOR PRO creates industry standard audio (Red Book) CD/DVDs from scratch that can be played on any home, car or portable compact disc audio player or computer CD/DVD or DVD-ROM drive. Audio tracks are created using any combination of 44.1 kHz, 16 bit stereo WAV or MP3 files.

To create an audio disc image:

· Click the Audio Image Editor. The screen will now display:


The Audio Image Editor tab is divided into three panes. The top left pane lists all the names and icons of the disk drives available to the DIRECTOR/DIRECTOR PRO, as well as files and folders on the currently selected disk drive (source). The top right pane displays the contents of any item you click on in the top left pane along with its icon. The bottom pane lists the names of audio files on the CD/DVD, which is being created (disc image) as well as their type (WAV or MP3), start position and end position, silence option (inserts silence into the audio disc image) and ISRC code. 

Audio Image Toolbar

Horizontally along the top above the panes is a toolbar that contains five buttons: New, Open, Save, and Disc Capacity.
Image Toolbar:

	New
	Creates a new audio disc image.

	Open
	Opens an existing audio disc image script folder to allow selection of an existing file (*.ISC)

	Save
	Saves the current disc image contents to an audio disc image script file (*.ISC).

	Disc Capacity
	Selects the capacity of the CD/DVD-R or CD/DVD-RW discs that are loaded into the DIRECTOR/DIRECTOR PRO:  74 minutes/650 MB or 80 minutes/700 MB. (DVD 3.95GB and DVD 4.7 GB are not used).


Adding Tracks

(
As depicted below, drag one or more WAV / MP3 files onto the text. Multiple files may be selected by pressing and holding down the SHIFT or CTRL key while clicking on the tracks. SHIFT allows you to select a range of contiguous tracks, while CTRL allows you to randomly pick multiple tracks. As additional tracks are added, drag and drop them in at the desired insertion point. 
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Selecting CD/DVD Capacity

On the horizontal toolbar is a button to select the capacity of the CD/DVD-R or CD/DVD-RW discs that are loaded into the DIRECTOR/DIRECTOR PRO: 74 minute/650MB or 80 minute/700MB (DVD 3.95GB and DVD 4.7GB are not used). 

The Disc Capacity will displayed in the lower right hand corner


Removing Tracks

· Right click on the audio track you wish to delete.

· Choose Delete Track from the drop down menu.

Editing A Track

(  Right click the track to be edited.  The screen will now display:
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The right hand buttons have the following options:

(  Play Selection

(  Set IN Point

(  Set OUT Point

(  Remove Subindex

These options allow custom changes to the tracks.  Choosing OK sets the changes and Cancel cancels the changes.

Changing ISRC Codes and Copy Prohibit Flags



The INTERNATIONAL STANDARD RECORDING CODE (ISRC) is an optional 12-character descriptor that identifies a specific track on an audio CD/DVD. Each track can have its own unique ISRC consisting of 2 alphanumeric characters (country), 3 alphanumeric characters (owner), 2 digits (year of recording) and 5 digits (serial number).

The COPY PROHIBIT flag is a setting in each track on an audio CD/DVD, indicating whether or not that track can be copied by a digital recorder.

To change an ISRC code:

· Double click the desired audio track in the lower pane. The screen will now display:
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· Enter the code in the ISRC line and click the OK button.

To change a Copy Prohibit flag:

· Double click the desired audio track in the lower left pane. The screen will now display:


· To enable Copy Prohibit select the Copy Prohibit box so that it is checked, or uncheck the box to disable Copy Prohibit.

Inserting, Editing And Removing Silence

When assembling an audio CD/DVD disc image the DIRECTOR/DIRECTOR PRO application does not insert silences (gaps) between tracks.

To insert silence between tracks:

· Right click the track that is to be edited.  Choose “Edit” on the drop down menu

· A pop up screen appears.  The Silence option appears in the middle of the screen with a slide control.  Slide the control to the preferred length of silence.  In the example:  48 seconds.


To edit the amount of silence between tracks:

· Double click the silence indicator you wish to edit in the lower left pane. The screen will now display:


· Click the up and down indicators to increase or decrease the duration of the silence (minutes, seconds, frames).

· Click the OK button.

To remove silence between tracks:

· Click the silence indicator you wish to remove in the lower left pane and hold down the mouse button.

· Drag the silence indicator over the trashcan in the bottom right of the 

· WaveMan tab and release the mouse button.

· Click the Yes button.

Inserting, Editing And Removing Sub-indexes

Sub-indexes are markers used by CD/DVD audio players to locate specific points inside an audio track. Sub-index 0 indicates the start of any silence before the beginning of a track and sub-index 1 indicates the beginning of a track’s audio material. Other sub-indexes can also be assigned to allow some audio players to locate specified material within a track itself.

To insert sub-indexes in a track:

· Click the audio track you wish to edit in the lower left pane and its existing sub-indexes will be displayed in the bottom right pane.

· Click the Insert Sub-index button. The screen will now display:


· Click the up and down indicators to specify the location of the sub-index (minutes, seconds, frames).

· Click the OK button.

To edit sub-indexes:

· Click the audio track you wish to edit in the lower left pane, and its existing sub-indexes will be displayed in the bottom right pane.

· Double click the sub-index you want in the bottom right pane. The screen will now display:

· Click the Insert Sub-index button. The screen will now display:


· Click the up and down indicators to specify the new location of the sub-index (minutes, seconds, frames).

· Click the OK button.

To remove sub-indexes:

· Click the audio track you wish to edit in the lower left pane and its existing sub-indexes will be displayed in the bottom right pane.

· Click on the sub-index you want in the bottom right pane and hold down the mouse button.

· Drag the sub-index over the trashcan in the bottom right of the Audio Image Editor tab and release the mouse button.

· Click the Yes button.

Saving The Current Audio Disc Image

Once an audio disc image has been created it must be saved so that it can be used by the DIRECTOR/DIRECTOR PRO as an audio source for recording. Disc images are saved as script files (with an “ISC” extension).

To save an audio disc image script file:

· Click the Save button on the toolbar. The screen will now display:
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· Select the volume and directory where you want to save the script file.

· Enter the name for the audio disc script file and click the Save button.

Loading An Existing Audio Disc Image

Once an audio disc image script file has been saved it can be modified at a later date.

To load an existing audio disc image script file:

· Click the Open button on the toolbar. The screen will now display: [image: image11.png]oven T
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· Select the appropriate file and click the Open button.

Status Tab



Click on Status Tab and the following window will be displayed:
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Removing A Job

To remove a pending job from the queue so that it will not be produced:

· Click the job you wish to remove in the JOB QUEUE window.

· Click the Remove Job button.

Clearing The Completed Jobs List

To clear the list of completed jobs:

· Click the Clear List button.
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Please be sure not to exceed the capacity of the disc being used.
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( CAUTION


Please ensure the Client Machine or workstation where D-Client is being used, does not have the “full” version of Acrobat installed.  Instead please install Acrobat Reader, v 6.0 or higher. 
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MF Digital Duplication Systems now allows you to create your Disc labels using the popular Adobe Acrobat File, PDF for printing.  To make this process simple, MF Digital has created PDF templates for you to design your artwork on.  These templates are located on our tech support page.  � HYPERLINK "http://www.mfdigital.com/techsupport.html" ��http://www.mfdigital.com/techsupport.html�





To use these templates, please follow the instructions below.  For this example we will use Adobe Photoshop.





Open Adobe Photoshop and from the File Menu, choose Open.  Browse to find the PDF template that you downloaded and choose that file, click the open button.  You will be alerted with an IMPORT PDF dialog window.  Fig. A


Click the OK button.


The template will open in Adobe Photoshop.  If you select the IMAGE menu, then choose Image Size, the image size dialog will appear, verify the Document Size, Height & Width reads the correct size for the template you are working with.  For this example, the document size reads, 119.94mm x 119.94mm.  Fig. B


When laying out text in Photoshop, Photoshop automatically creates a new layer, one for each piece of text you add, should you need to insert a graphic.  From the Layer Menu, choose LAYER->NEW LAYER.  Photoshop will insert a new layer for you.  You can then add the graphic onto this layer.(Yellow Square)  Fig. C
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DIRECTOR/DIRECTOR PRO systems equipped with Pioneer DVD-R drives do not support MF Digital SmartDRIVE features.





Note:
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After you lay out your design, the template layer needs to be “turned off”.  This simply done by using the layers palette. (red square, Fig. D) You’ll notice to the left of each layer is an eye.  Clicking the eye will turn that layer off.  Notice the template now disappears. Fig. E


You will now need to convert your design into a PDF file, to do this, make sure you have Adobe Acrobat installed.  From the File Menu, choose Print.  Under the Printer section of the Print Dialog, change the Printer name to the PDF Printer (acrobat versions vary in names).  Fig. F Click the OK button.


You will be prompted to give a name to the PDF file.  The default name that should be used for Standalone units, is 1.PDF.  If this is a multi set of labels, then label the PDF filename accordingly (example, 1.PDF, 2.PDF, etc.).  Fig. G
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